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PLEASE NOTE The information contained herein is based on the experience and knowledge relating to the 
subject matter gained by Eastman Kodak Company prior to publication.

No patent license is granted by this information.

Eastman Kodak Company reserves the right to change this information without notice, and 
makes no warranty, express or implied, with respect to this information. Kodak shall not be 
liable for any loss or damage, including consequential or special damages, resulting from any 
use of this information, even if loss or damage is caused by Kodak’s negligence or other fault.
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Section 1: Introduction
This manual describes the new features added to MPC for Windows in Version 2.1 and 
provides instructions for installing this new version. In addition, this manual describes the key 
combinations used to access MPC menus and provides definitions for abbreviations used in 
MPC displays and menus.

For information on all other MPC functions, refer to the help files included with the MPC 
software or to Appendix A: Security Mechanisms, Menus, and Windows.

MPC for Windows is a software service tool for Kodak LASER IMAGERS and related 
products used for setup of configuration parameters and diagnosis of malfunctions.

MPC for Windows Version 2.1 is used to service the following Kodak products:

• Kodak DryView 8500 LASER IMAGER

• Kodak DryView 8700 LASER IMAGER

• Kodak Digital Science 969 LASER IMAGER

• Kodak Digital Science XP535 FILM PROCESSOR

• Kodak DryView 8800 MULTI-INPUT MANAGER

New Features in Version 2.1:

• Softkey authentication

• Film type selection

• Optics test

• Image tests

• Machine serial number entry

Improvements in Version 2.1

• Improved Monitor feature.

• Expanded Configuration and Versions display

• Expanded Error History Log
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Minimum LAPTOP COMPUTER system requirements to run MPC for Windows:

• Pentium-based PROCESSOR

• 32 MB RAM

• 10 MB HARD DISK

• One of the following operating systems:

– Windows 98

– Windows NT 

– Windows 2000

Associated tools: 

The following LOOPBACK CONNECTORS for INPUT MODULES are required to run the 
diagnostic tests in MPC for INPUT MODULES.

• DB9 male connector 78-8075-2585-8 with:

– pins 2 and 3 tied together

– pins 7and 8 tied together

• DB37 male connector 78-8077-4211-5 with:

– pins 16 and 17 tied together

– pins 35 and 36 tied together

Software for MPC for Windows Version 2.1

Software installation files for MPC Version 2.1 will be available on a future version of the 
Service Collection for Health Imaging Division CD-ROM.
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Section 2: Installation

Installing MPC for Windows Version 2.1
1 Close all applications on your LAPTOP COMPUTER.

2 Is there an old version of MPC on your LAPTOP COMPUTER?

3 Remove the old version of MPC.

a Make temporary copies of the following 2 MPC Phone Book files:

• Phone.mdb

• Phone.ldb

Note
The 2 Phone Book files are located in C:\Program Files\MPC.

Note
If a message notifies you that the Phone Book files are locked or Read-only and cannot be 
copied, do the following:

1. In Windows Explorer, go to folder C:\Program Files\MPC for Windows 2.1

2. Right click the file Phone.mdb

3. Select Properties

4. Uncheck the Read-only box

5. Click OK

6. Repeat steps 2 through 5 for the file Phone.ldb

You should now be able to copy the 2 Phone Book files.

b From the Windows Control Panel double-click [Add/Remove Programs].

Yes No

Continue with Step 3. Advance to Step 4.(go to page 10)
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c Select Hardlock Device Driver.

d Click [Add/Remove].

e Click [Automatic].

Hardlock Device Driver
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f Click [Next].

g Click [Finish].

h Wait for the software to be removed.

i Check that the Hardlock Device Driver has been removed.

Hardlock Device Driver
removed
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j From the Add/Remove Programs Properties window:

• Select MPC for Windows”.

• Click [Add/Remove].

k Wait while the software is removed.

MPC for Windows
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l Click [Finish]

m In the Add/Remove Programs Properties window, check that MPC for Windows has 
been removed.

n Click [Cancel].
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4 Install MPC for Windows version 2.1 on your LAPTOP COMPUTER.

a From the Control Panel, double-click Add/Remove Program.

b Click [Install].



SOFTWARE INSTRUCTIONS Installation

11JUL03 
Revision A

8E7007
Page 

11 of 103

c Insert the KHI Service Collection CD into your LAPTOP COMPUTER.

d Click [Next].

e Click [Browse].
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f On the CD-ROM, find the file Mpc\Mpc_2.1\Setup.exe

g Double-click the file {Setup.exe].

h Click [Finish].

i Follow the installation instructions.

CD-ROM DRIVE
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j If the Locked File Detected window appears, click [Ignore]. See Important below.

k Click [Finish].

l Close the Control Panel.

m Shut down and restart your LAPTOP COMPUTER.

n Use Windows Explorer to copy the 2 Phone Book files you stored in Step 3a, on 
Page 5, to the folder C:\Program Files\MPC for Windows 2.1”.

o Start MPC to verify that version 2.1 has been installed. See “MPC Authentication 
and Start-Up.” on Page 14.

This completes installation of MPC for Windows Version 2.1.

Important
If the Locked File Detected message is displayed in step j, you must clear the Read Only  
properties that caused the message:

• Using Windows Explorer access folder c:\Program Files\MPC for Windows 2.1.

• Select the Phone.idb file, right click, select Properties, and remove the checkmark from 
the Read Only selection box.

• Select the Phone.mdb file, right click, select Properties, and remove the checkmark from 
the Read Only selection box.
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Section 3: Changes in Version 2.1

New Features in MPC

The following features have been added in Version 2.1.

• MPC Softlock Authentication

• Machine Serial Number Entry

• CE Mark - Film Type Selection

• Image Tests

Improvements in MPC
The following 3 features have been improved or expanded in Version 2.1

• Configuration and Versions Display

• Monitor Feature

• Error History Log 

MPC Authentication and Start-Up
A new softlock security option allows you to start MPC by entering a username and 
password. You can use either softlock authentication or a HARDLOCK KEY to activate MPC 
version 2.1. Softlock authentication provides access to 2 new features:

• CE Mark - Film type selection

• Image tests

If you use a HARDLOCK KEY, these new features are not available.

Softlock usernames and passwords will be issued to students in training classes for the 
products that require MPC. Field engineers can also obtain a username and password from 
TAC.

To start MPC Version 2.1:

1 Connect your LAPTOP COMPUTER to the IMAGER you are servicing.
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2 Double-click the MPC Icon on your desktop.

3 Are you using a HARDLOCK KEY?

4 Start MPC with Softlock.

a Enter your Username and Password.

If the username and password are valid, MPC will start and display the main MPC 
screen.

b Click [Authenticate].

5 Click [This computer has a Hardlock Attached]. MPC will start and display the main MPC 
screen.

Note
If you are connecting to a Kodak DryView 8700/8500 IMAGER, MPC Version 2.1 will prompt 
you to enter the serial number of the IMAGER if a machine serial number has not been 
entered previously. See “Serial Number Entry.” on Page 17. 

No Yes

Continue with Step 4. Advance to Step 5.
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MPC Main Screen

You can access all of the MPC setup and diagnostic functions from the Main Screen.
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Serial Number Entry
This feature applies to Kodak DryView 8700/8500 LASER IMAGERS only.

When you start MPC Version 2.1, it will prompt you to enter the machine Serial Number, if:

• The SCB firmware is version 1.26 or greater and,

• The machine Serial Number has not been entered previously.

The following screen will appear after the MPC Authentication window.

1 Enter the Machine Serial Number of the IMAGER you are servicing.

The serial number must be in the range 8700000 to 8799999 or 8500500 to 8599999

2 Is the serial number between 8700500 and 87xxxxx?

3 Enter the serial number again to verify the number.

No Yes

Advance to Step 4. Continue to Step 3.
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4 Click [Save].

Note
The serial number feature applies only to Kodak DryView 8700/8500 LASER IMAGERS. The 
serial number is stored in the SCB. If you replace the SCB, you will have to re-enter the 
serial number.

Correcting a Serial Number
To correct a serial number that has been entered incorrectly into Kodak DryView 8700/8500 
LASER IMAGER:

1 Select Operations>Setup.
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2 Click:

• [SCB] or [MCS]

• [Config]

For a stand-alone 
Kodak Dryview 

For all other imager

8700/8500 LASER
IMAGER

systems
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3 Type in the correct Machine Serial Number of the IMAGER you are servicing.

The serial number must be in the range 8700000 to 8799999 or 8500500 to 8599999.

4 Is the serial number between 8700000 and 87XXXXX?

5 Enter the serial number again to verify the number.

6 Click [Save].

No Yes

Advance to Step 6. Continue to Step 5.
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CE Mark and Film Type Selection 
You can use MPC version 2.1 to specify the types of film a Kodak DryView 8700/8500 
IMAGER will accept.

You can set the IMAGER to accept:

• All types of Kodak DryView film cartridges that fit the film tray or,

• One or more types of Kodak DryView film cartridges labeled with the CE Mark

If you started MPC with a HARDLOCK KEY, the CE Mark and Film Type selection feature is 
not available. The IMAGER will accept all types of film.

To set Film Type:

1 Select Operations>Setup.
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2 Click:

• [MCS]

• [Config]

3 Click [CE Mark / Film Types].

Not present if you 
used a HARDLOCK
KEY to start MPC
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4 Select either:

• All or

• CE Marked Cartridges Only

5 Did you select CE Marked Cartridges Only? .

6 Select one of the Film Types Accepted

The IMAGER will accept only the film type you selected.

7 Click [Save Changes].

Yes No

Continue with Step 6. Advance to Step 7.

Types of film cartridges
with CE Mark
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Image Tests
MPC version 2.1 includes 5 new tests:

• Print a Calibration image

Initiates a CALIBRATION PRINT, the same as pressing the Calibration button on the 
LOCAL PANEL.

• Print a Grey Out image

Prints a solid gray image. The user can select the shade of gray.

• Initiate Transport Only films

Initiates the movement of a film from the input tray through the imager. No image is 
printed on the film.

• HIB (SMPTE) Test (dual-printer configuration only)

Prints a film with a SMPTE pattern.

• Optics test

View test data and error codes from the optics self-test.

Image Test Procedures
To run the image tests:

1 Select Operations>Diagnostics.
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2 Click [SCB] or [MCS].

3 Select Printer 0 or Printer 1.

4 Click [Image Test].

For a stand-alone Kodak 

All other IMAGER

DryView 8700/8500 IMAGER

SYSTEMS
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You can select any of the 5 image tests from the Print Test Images window

Calibration Test
This test prints the same Calibration film that is printed when the user presses the Calibration 
button on the LOCAL PANEL.

To initiate the Calibration test:

1 Click [Calibration].

2 Wait for the IMAGER to print the Calibration film.

3 If you are done with Image Tests, click [Close].
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Grey Out Test
This test prints a test film with a uniform gray test pattern. The Attenuator Setting selects the 
shade of gray: 
0 = clear, 480 = black. The default setting is 190, a medium shade of gray.

To run a Grey Out test film:

1 Enter an Attenuator Setting.

2 Click [Grey Out].

3 Wait for the IMAGER to print the Grey Out film.

4 If you are done with image Tests, click [Close].

The gray level should be uniform throughout the film. Variations in the gray level indicate that 
the IMAGER is not operating properly.
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Transport Only Test
This test moves 1 or more films from the INPUT TRAY through the TRANSPORT 
MECHANISM of the IMAGER without printing images on the films. This test is used for PM 
procedures and for troubleshooting transport malfunctions.

The LASER in the IMAGER is disabled during this test.

Bypass Warmup Feature
This feature is used along with Transport Only tests. It allows transport tests to run during the 
warm-up cycle of the IMAGER. Normally the IMAGER cannot run films during warm-up. 

Note
By-Pass Warm UP does not override the warm-up cycle for Calibration or Grey Out test 
prints.

The user can call up a Sensor screen to monitor the action of the FILM SENSORS as film 
moves through the IMAGER.

To run the Transport Only test:

1 Select the number of films from the Transport Setting pull-down list.
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2 If you wish to run Transport Only films during the warm-up period, click [By-Pass Warm-
up].

3 Click [Transport Only].

4 Click [Sensor] on the toolbar to display the Sensors screen.

5 Wait for the IMAGER to run the Print Only films.

Check marks will appear in the sensor boxes during the time the moving film actuates 
each sensor.

6 If you are done with image Tests click [Close].
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HIB Internal (SMPTE) Test
This test applies only to the Kodak DryView 8700 LASER IMAGER dual printers only.

The HIB test prints a film with a SMPTE pattern. (This SMPTE test image is stored on the 
HIB.)

To run the HIB test:

1 Select a density from the pull-down list.

2 Click [HIB Internal].

3 Wait for the IMAGER to print the SMPTE film.

4 If you are done with image Tests, click [Close].

Density pull-down list
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Optics Test Monitor
The optics test applies only to the Kodak Dryview 8700/8500 LASER IMAGERS.

The optics test checks the function of the LASER OPTICAL SYSTEM in the IMAGER and 
measures several parameters related to the OPTICAL SYSTEM. The test runs automatically 
when the SCB boots up. 

The Optics Test monitor in MPC allows you to view and capture optics test data and error 
codes. Test results and error codes appear on an MPC Optics Test screen and are also 
stored in a file on your LAPTOP COMPUTER.

To monitor the Optics Test:

1 Click [Optics Test].
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2 Prepare the IMAGER for the Optics Test.

a Make sure the IMAGER is energized.

Warning
Dangerous Voltage

b Remove the RIGHT SIDE PANEL from the IMAGER. See SERVICE MANUAL 
1202688

Section Procedure

Disassembly/Reassembly 4-1-3. Right Side Panel
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c Remove the ELECTRONICS ENCLOSURE COVER. See SERVICE MANUAL 
1202688. 

d Open the SWING-OUT INNER PANEL.

3 Press the RESET BUTTON.

This reboots the SCB. The optics test starts after a 10-second delay and runs for about 4 
minutes.

4 Click [Start] in the Optics Test window within 10 seconds.

Section Procedure

Disassembly/Reassembly 4-1-4. Electronics Enclosure Cover

SWING-OUT
INNER PANEL

RESET BUTTON

SCB
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Optics test data will scroll through the Monitor window. 

• You can Click [Abort] to stop monitoring the test.

• If the test runs without errors, None appears in the Error window.

• If an error occurs, the test will stop and an error code or line number along with an 
explanation of the error will appear in the Error window.

The test data and error information are stored on your LAPTOP COMPUTER at the location 
shown in the File window.

• A new file is stored each time you run the Optics Test monitor.

• The File name is OpticsTest followed by the date and time: mmddyyhhmm. For example, 
OpticsTest 0924021024 where the date is 9/24/02 and the time is 10:24.

• The test result files are text files that you can read with the Windows Word Pad accessory 
or Microsoft Word.

Test data scrolls
through this window

Error codes appear
in this window

Test results are stored
as this location
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The following table describes the entries in the optics test that appear in the Monitor window. 
The values shown in the Test Item column are typical values and will not be the same for all 
IMAGERS.

Table 1 Description of Test Results in Monitor Window

Test Item Explanation

emaxMax, emaxMin =  3150, 2250 EMax Max,  EMax Min: Maximum and Minimum Laser 
power that does not saturate the Beam Power Monitor

pmOffs et = 10 PM Offset : Beam Power Monitor Offset a number 
between 1 and  25, usually  3 +/- 3.  If out of range, 
error 601 occurs.

Ltest = 30 60 Ltest: A digital value assigned to the Laser Power and 
used to perform the following tests.

pmAttenOpen = 3 198 
{2276..3882}

PM Atten open: Power Monitor reading with Attenuator 
wide open. Should be 2250 to 3882. If not, error 602 
occurs.

A ODrange = 0.954243  
{0.800000..1.200000 }

AOD Range: Attenuator Optical Density Range, a 
number between 0.8 thru 1.2.  If out of range, error 603 
occurs.

laserDynamicRang e = 3238 Laser Dynamic Range: A ratio of Max and Min power. 
should be between 200 thru 4000.  If out of range, 
error 604 occurs.

pmLtest =  820 PML Test: The Attenuator position used to accomplish 
the following tests.

pmLaserMin, p mLaserMax = 1, 
3238

pmLaserMin, p mLaserMax = 1, 3238.

pmLaserMin, p mLaserMax = 1, 
3238

PM Laser Min,  PM Laser Max: Minimum and 
maximum laser power at the above Attenuator setting – 
a number between 1 to 2995.

Pabsmax = 63.1410 03 PABS Max: Power absolute Max in milliwatts. Should 
be between  50 - 70 milliwatts. If out of range, error 
605 occurs.
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In addition to the above errors, the following errors are identified by line numbers in the test 
code. If one of these errors occurs, the optics test will stop and the line number along with an 
explanation will appear in the Error window.

Table 2 Line Number Errors

Line Number Description

412 or 422 Attenuator cannot be set correctly

526 or 536 Cannot find max position of attenuator

842 or 852 Timed out waiting for X galvo to phase lock.
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Configuration/Version Display
This screen has been revised to display 3 new items:

These items apply only to the Kodak DryView 8700/8500 LASER IMAGER.

RFReader PCB Rev The revision level of the RF Reader Board on the RF Tag Rollback 
Module.

RFInterface PCB Rev The revision level of the RF Interface Board on the RF Tag Rollback 
module.

Emulsion Number The emulsion number of the film cartridge in the IMAGER.

Added in Version 2.1
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Monitor Feature
The Monitor display allows you to view communication activity on the SERIAL PORTS for 
user inputs or for printer outputs. 
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You can monitor the following SERIAL PORTS.

When you start the Monitor, a series of entries showing communication activities appear on 
the Monitor screen. You can choose to store this data on your hard disk or on a floppy disk.

Product Serial Ports that can be monitored

Kodak DryView 8700/8500 LASER 
IMAGER

The 2 SERIAL PORTS that connect KEYPADS or 
host control inputs to the IMAGER

Kodak Digital Science 969 LASER 
IMAGER

• The 2 SERIAL PORTS on each INPUT MODULE 
that connect to KEYPADS or host control inputs.

• The 2 SERIAL PORTS on each OUTPUT 
MODULE that connect to a PRINTER and 
PROCESSOR.

Kodak DryView 8800 Multi-Input 
Manager

The 2 SERIAL PORTS on each INPUT MODULE that 
connect to KEYPADS or host control inputs.
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The Monitor window includes the following items:

Monitor Item Description

Time stamp box When this box is checked, the date and time are automatically 
entered on each monitor entry.

Trap feature This feature allows you to detect a specific error code or other 
text string in the monitor data. The number of occurrences are 
counted.

• Text box - Enter the error code or text to be detected in this 
box

• Set box - Check this box to activate the Trap feature.

• Tripped box - The Monitor checks this box the first time the 
text in the Text box occurs.

• Count box - This box shows the number of times the text in 
the Text box is detected during a monitoring session.

• Reset Count button - Click this button to set the Count 
to 0.

File Save As button You can choose to save the monitor data to your hard disk or to 
a floppy disk. 
To save a Monitor file:
1. Click [File Save As], before you start monitoring.

2. Enter the path and file name of the receiving file. 

Saving will begin when you start monitoring.

File Name The path and file name that is used for the File Save As option.

Start button Click to start monitoring.

Stop button Click to stop monitoring.
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Slots to be Monitored Used to select the serial ports to be monitored. 

• For stand-alone Kodak DryView 8700 and 8500 IMAGERS, 
only 2 Slots appear on the Monitor screen. Slot 0 selects 
User Input 0, Slot 1 selects User Input 1. You can monitor 
both user inputs at the same time.

• For the Kodak DryView 8800 MULTI-INPUT MANAGER and 
the Kodak Digital Science™ 969 LASER IMAGER, the Slot 
numbers refer to SLOTS in the IMS CARD CAGE. When you 
select a SLOT, the two SERIAL PORTS on the MODULE in 
the SLOT will be monitored. You can monitor any 2 SLOTS at 
the same time.

Review Log When you check this box, the monitor screen is split into 2 parts. 
One part displays the current monitor data. The second part 
displays the entire monitor file which is stored in a buffer. You 
can scroll backward and forward through the entire monitor file.

Add comment box To add a comment to a line in the monitor file:
1. Type your comment in the Add comment box”.

2. Press [Enter] on your LAPTOP COMPUTER keyboard.

The comment will be inserted as the next line in the monitor file 
after you press [Enter].

Monitor Item Description
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Section 4: MPC Key Combinations
Key Combinations

If you don’t have a mouse, you can use the functions in the MPC window with the following 
combination of keystrokes:

• ALT+x: opens items on the Menu bar or Toolbar. x = the access key for the underlined 
letter on a menu.

For example: ALT+O+U opens the list of subsystems. Use the Up and Down arrows to 
scroll through the list, or add the underlined letter to the keystroke series to open a 
specific subsystem (e.g., ALT+O+U+S opens the SCB window, ALT+O+D opens the 
diagnostics window, etc.).

Note
If the same underlined letter appears in both the Menu bar and the Toolbar, the Toolbar 
option overrides the Menu bar option.

• TAB KEY is used to move among fields that do not have an underlined letter.

•  UP, DOWN ARROWS: move vertically through a drop-down list.

• RIGHT, LEFT ARROWS: move horizontally through the Menu bar.

• SHIFT+x: selects an item from a Menu drop-down list. x = the access key for the 
underlined letter on a menu.

• ESC: closes a menu list without making a selection.
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Appendix A:  Security Mechanisms, Menus, and Windows 

This section addresses the topics of security, menus, and the types of windows within MPC. 

 Security Mechanisms 

One of the requirements of MPC is to provide a security mechanism such that unauthorized users 
cannot gain access to MPC functionality. MPC’s initial screen should allow the field engineer to use 
either the softkey or hardlock form of security. 

 SoftKey 

The softkey security for MPC consists of a username and password. This username-password 
combination is used for MPC authentication to allow access to MPC functionality. The username 
consists of three or four components, depending upon the type of user. The password is a 
scrambled set of characters that can be calculated given the username, using a modified 
encryption algorithm. 

Once the field engineers have a valid username and password, they may log in by entering their 
username and password and then clicking the Authenticate button in the MPC Authentication 
window. If they are valid, the field engineer will be granted full access to MPC. 

 Field Engineer User 

The field engineer is a user that has full access to MPC.  

Each field engineer as assigned a username and password to access MPC. 

Usernames 

The username consists of seven (7) characters: 

 Passwords 

Passwords are alpha-numeric and contain 8 characters. 
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 Login 

The login process takes place when MPC boots. A window appears that allows the field engineers 
to enter their username and password. If the field engineers enter valid information, they will be 
granted access to that specific imager for as long as they do not exit the MPC application. If the 
field engineers enter invalid account information, they will be prompted with an error message. 

 Hardlocks 

A hardlock is a physical device that attaches to the parallel port. The software checks to see if there 
is a hardlock. If there is not, the software exits the program. On the MPC Authentication window 
the user must click the This computer has a Hardlock Attached button to gain access to MPC. 



 

 

 
 

Pub. No. 
8E7007 
11JUL03 

Revision A 
Pg 46 of 103 

SOFTWARE INSTRUCTIONS Security Mechanisms, Menus, and Windows 

 Menus 

Eight primary menus constitute the MPC menu system: 

• File 

• Edit 

• Operations 

• Utilities 

• Log 

• Images 

• Window 

• Help 

Refer to the paragraphs that follow for more detailed information on each menu. 

 File 

The File menu consists of four submenus: 

• Refresh Menus 

• Backup 

• Restore 

• Exit 

Refer to the paragraphs that follow for more detailed information. 
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 Refresh Menus 

When this menu item is selected, the software polls the connected device to determine what type of 
imager is connected, and then configures all menus and parameter windows accordingly. This 
allows a connection to be reestablished without the user having to exit and restart the MPC for 
Windows program. 

 Backup 

This menu selection is used to create a backup file containing parameter settings currently stored 
in NVRAM. The backup file can contain the parameter settings for the entire system or a single 
user. A single user backup can be used as a script file on a different system. 

 Restore 

This menu selection is used to copy parameter settings from a backup file into NVRAM within the 
appropriate system components. 

 Exit 

This menu selection is used to exit the MPC for Windows program. Remote connections are 
automatically disconnected when MPC for Windows is exited. 

 Edit 

The Edit menu consists of one submenu, Copy. Refer to the paragraph that follows for more 
detailed information. 

 Copy 

This menu selection enables the user to copy selected text to the clipboard. 
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 Operations 

The Operations menu consists of eight submenus. 

• Setup 

• Diagnostics 

• Subsystem 

• Monitor 

• Preferences 

• Phone Book 

• Manual Dial 

• Disconnect 

Refer to the paragraphs that follow for more detailed information. 

 Setup 

This menu selection is used to put the MPC for Windows program into Setup mode. 

 Diagnostics 

This menu selection is used to put the MPC for Windows program into Diagnostics mode. 

 Subsystem 

This menu selection displays an additional menu that lists the various subsystems that can be 
configured (when in Setup mode) or tested (when in Diagnostics mode). Selecting a subsystem 
from this list is equivalent to clicking on the related subsystem button. 
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 Monitor 

This menu selection is used to monitor communications between control devices (keypad or host) 
and input modules or between the output module and the imager. 

 Preferences 

This menu selection displays the Preferences window, which is used to configure various MPC for 
Windows operating parameters. 

 Direct Connect 

Specifies the baud rate and serial port to use when the MPC is connected directly (via serial cable) 
to the IMS. 

 Remote Connect 

Specifies the baud rate and serial port to use when the MPC is connected remotely (via modem) to 
the IMS. 

 User Display 

Specifies whether users listed in the component select drop-down list box are identified by 
slot/comm or modality name. 

 Operation 

Specifies the overall operating mode of the MPC for Windows software. There are two basic modes 
of operation: Normal and Demo. 

 Normal 

The normal operating mode of the software. When the MPC for Windows program is started (or 
whenever the Refresh Menus item is selected from the File Menu), the software polls the 
connected device to determine what type of imager is connected, and then configures all menus 
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and parameter windows accordingly. Parameter windows the imager’s NVRAM settings. As the 
parameters are saved, they are written into NVRAM. 

 Demo 

Various demo modes are provided with a tutorial of the software. When in demo mode, the imager 
model is selected. Parameter windows display default and/or sample settings. When parameters 
are saved, they are written to a temporary file. In demo mode, MPC does not need to be connected 
to an imager. 

 Monitor 

Specifies whether or not to save monitored communications during a monitor session. If so, the 
communications will be saved to the hard disk or a floppy. 

 Modem Initialization 

Specifies an initialization string to be sent to the MPC modem. This string is sent prior to any dialing 
commands. 

 Serial Time Out 

Specifies the delay, in milliseconds, for the serial port during the video download. 

 Phone Book 

This menu selection displays the Remote Connect Phone Book window. 

The Phone Book stores a list of customer sites, along with the phone number of the service 
modem. A contact name and phone number can also be entered for each site. The entries are 
listed in alphabetical order based on the hospital name. MPC automatically dials a highlighted 
number from this menu. 
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 Manual Dial 

This menu selection enters and dials the phone number of the service modem at a remote 
customer site. The field engineer needs to enter a phone number on a command line from this 
menu. 

 Disconnect 

This menu selection is used to disconnect a remote connection without exiting MPC for Windows. 

Note: Remote connections are automatically disconnected when MPC for Windows is exited. 

 Utilities 

The Utilities menu consists of four submenus. 
• Version 

• Print Count 

• Clock 

• Maintenance Port 

Refer to the paragraphs that follow for more detailed information. 

 Version 

The Version window displays the following information: 

• A list of users, identified by slot/comm and modality name. 

• A list of input modules, with the memory size (in mega pixels), memory width (in bits), and the 
TFT EPROM version for each module. 

• The versions of the printer, processor, and IMS system controller firmware. (The system 
controller firmware version is displayed in the upper-left corner of the window.) 
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• On an RFTag machine, version will show RFReader and the RFInterface boards revision 
numbers. The Emulsion Number is also displayed. If the Emulsion Number is not present, 
SHOW N is displayed. 

 Print Count 

The Print Count window displays the overall print count for the laser imager, as well as the 
individual print count for each user. The window also allows the print count to be cleared. 

 Clock 

The Clock window is used to set the system clock on the laser imager. 

 Maintenance Port 

The Maintenance Port window allows the user to 

• Specify the baud rate for Port A on the IMS system controller. 

• Specify the baud rate for Port B on the IMS system controller. 

• Specify the number of rings required before the internal modem will answer a remote call from 
the MPC. 

• Specify whether the MPC port on the IMS starts up in Maintenance or Console mode. 
Maintenance mode is the mode that will allow MPC to communicate with the IMS. Console 
mode is a terminal mode for the IMS. 

• Specify whether the IMS boots up in Normal or Debug mode. 

• Display the default settings for all of the Maintenance Port parameters. (To save the default 
settings to NVRAM, select the Save button before selecting the Close button.) 
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 Log 

The Log menu consists of three submenus. 

• Error History 

• Error Tally 

• Printer Log 

The Log menu displays the log files in a window. Refer to the paragraphs that follow for more 
detailed information. 

 Error History 

This menu selection contains the error history listing for a selected input or output module. 

Errors are listed in chronological order, with the most recent error at the top of the listing. The date 
and time and the number of prints are listed for each error. The film type is listed for Slot 0. 

In an error log for an 8500/8700 with RFTag, the film column format is: 

Film Type (1st two characters) Lot number-Jumbo-Band-Cartridge number 

The complete file name in which the error history will be saved is defined in the Save Error History 
window. 

 Error Tally 

This menu selection contains the error tally listing for a selected input or output module. The error 
tally lists each type of error that has been logged, along with the count of occurrences in the error 
log. 

 Save Error Tally Window 

The Save Error Tally window is used to specify the name of the file in which to save the error tally, 
as well as the drive and directory in which the file is located. 
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By default, the drive and directory are set to the location of the MPC for Windows software, typically 
"C:\Program Files\MPC for Windows 2.0". 

By default, if a new error tally file name is entered without an extension, a .ET extension is 
automatically added. A different extension can be used; however, this will prevent the file name 
from automatically appearing in the File Name list box in the Save Error Tally window. 

 Printer Log 

This menu selection displays the Log Display Window, which contains values for a selected 
parameter. 

 Log Display Window 

This menu selection displays values for the parameter selected in the pull-down list when the 
Retrieve button is selected. 

 Images 

The Images menu consists of three submenus. 

• Show 

• Notify 

• Delete 

The Images menu displays the images that are in memory or deletes the images. Refer to the 
paragraphs that follow for more detailed information. 
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 Show 

This menu selection displays the Images in Memory window. 

 Images in Memory Window 

This window displays a list of the images currently in memory for each user. Image ID number and 
size (pixels and lines) identify images. 

 Notify 

This menu selection sends a message to the user(s) connected to the selected input module, 
notifying them to complete their current operation and erase all images. 

A list of input modules can be displayed from the Notify from the Images option. After selecting an 
input module from the list, the field engineer can then continue with the Notify operation or cancel. 

 Delete 

This menu selection is used to delete all images from memory on the selected input module, from a 
list of input modules 

After selecting an input module from the list the field engineer can continue with the Delete 
operation or cancel. 

 Window 

The Window menu consists of four submenus. 

• Close 

• Close All 

• Cascade 

• Tile 
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The Window menu assists in the viewing of windows in the Data Windows area of the screen. 
Refer to the paragraphs that follow for more detailed information. 

 Close 

Closes the currently active window. 

 Close All 

Closes all open windows. 

 Cascade 

Arranges open windows so that the title bar of each window is visible. 

 Tile 

Arranges open windows side by side so that portions of all windows are visible. 

 Help 

The Help menu consists of two submenus. 
• Contents 

• About 

The Help menu provides help information on an MPC subject. Refer to the paragraphs that follow 
for more detailed information. 

 Contents 

This menu selection opens the MPC for Windows Help file and displays the Contents. 

 About 

This menu selection displays the version number of the MPC for Windows software. 
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 Data Windows 

Data windows display information about the imager. 

 IMS Setup Windows 

The IMS Setup windows are displayed when the user selects the IMS subsystem and Setup under 
the Operations menu. 

 Output Module Configuration Window 

The Output Module Configuration window is displayed when the user selects the Config window 
display button and an Output Module when in IMS Setup for the M8800. 

 Operating Mode 

Specifies whether the selected output module is connected to a 969 or an 8700. 

 IMS Communication Parameters Window 

The IMS Communication Parameters window is displayed when the user selects the COMM button 
when in IMS Setup. 

Note: 

• Changes to IMS Communication Parameters will not take effect until the imager power has 
been cycled. 

• The 8700 Keypad and Siemens defaults buttons are only displayed when the MPC is connected 
to an 8700. 

 Data Bits 

Specifies the number of data bits used for serial communications on the selected comm port. 
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 Stop Bits 

Specifies the number of stop bits used for serial communications on the selected comm port. 

 Parity 

Specifies the type of parity used for serial communications on the selected comm port. 

 Parity Enable 

Specifies if parity checking is enabled for serial communications on the selected comm port. 

 Command Set 

Specifies the command set used by the remote keypad or host control device. 

 Baud 

Specifies the baud rate used for serial communications on the selected comm port. 

 End Of Message 

Specifies the character(s) used to indicate the end of a serial command or response. 

 Protocol 

Specifies the type of communications protocol to use for the selected comm port. 

 Character Pacing 

Specifies the delay between characters used for serial communications on the selected comm port. 
A setting of 6 produces a delay of approximately 1 ms. 

 Defaults Buttons 

Displays the default communication parameter settings for selected default. 
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 969 Cmd Set Defaults Button 

Displays the default communication parameter settings for 969 command set. Note that for the 
default parameters to remain in effect, the parameters must be saved to NVRAM. 

 959 Cmd Set Defaults Button 

Displays the default communication parameter settings for 959 command set. 

 Printer Defaults Button 

Displays the default output module-communication-parameter settings. 

 8700 Keypad Defaults Button 

Displays the default communication parameters for 8700 keypad. 

 Siemens Defaults Button 

Displays the default communication parameters for Siemens host control and displays the Siemens 
Translation Configuration window. 

 8300 Keypad Defaults Button 

Displays the default communication parameters for 8300 keypad users. 

 Siemens Translation Configuration Window 

Sets up parameters for a Siemens modality so that the imager can understand it. 

 Modality 

Specifies the type of Siemens modality connected to the imager. The modality types are Range: 
Somatom, Magnetom, Flourospot_H, Sienet, and other. 
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 Timeout 

Specifies the time (in seconds) allowed for a successful acquisition. 

 Delay 

Specifies a delay (in seconds) in the imager’s response to a host-acquisition command, reducing 
the risk of obtaining memory full errors in a host-controlled environment. 

 Smooth Beta 

Specifies the interpolation table to use when smooth image processing is selected. 

 Sharp Beta 

Specifies the interpolation table to use when sharp image processing is selected. 

 Error Code Mode 

Specifies the type of error codes to be returned to the modality. 

 Image Parameters Window 

The Image Parameters window is displayed when the user selects the IMAGE button when in IMS 
Setup and input is selected. 

 Contrast 

Specifies a default contrast setting for host control users. This setting is overwritten by a 969 
keypad. 

Range: 1 to 30 (1 to 15 are positive tables; 16 to 30 are negative tables) 
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 Dmax 

Specifies a default Dmax setting for host control users. This setting is overwritten by a 969 keypad. 

Range (969/959): 1.7 to 3.2 

Range (8700): 1.7 to 3.0 

 Density 

Specifies a default density setting for host control users. This setting is used when AIQC is off (e.g., 
when films are being sent to the receive magazine). 

Range: 1 to 16 

 Border 

Specifies a gray level to use for image borders. This value is only used for host control users that 
do not set image border. This setting is overwritten by the 969 keypad. 

DryView 8700 users cannot select clear borders. Field engineers can change the Border setting to 
4095 in order to produce clear borders when setting up video inputs for an 8700. The setting must 
be changed back to 0 after video setup is complete. 

 969 Cmd Set Horizontal Beta 

Specifies a default horizontal-interpolation beta table for 969 command set host control users. 

 969 Cmd Set Vertical Beta 

Specifies a default vertical-interpolation beta table for 969 command set host control. 

 Match Border 

Specifies whether border density will equal image Dmax (set to Yes) or film Dmax (set to No). 
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 Dmin Mode 

Specifies a Dmin setting to be used by the imager. The settings are: 

• Normal – set to film Dmin. 

• Hold Transfer Function – Dmin will be set to the value in the defined Transfer Function Table. 

• Force Dmin – the highest digital input value of the media that is mapped to the absolute 
minimum laser power. 

 Transfer Function Tables 

Specifies which Transfer Function Table setting is to be used. 

 959 Command Set Options Window 

The 959 Command Set Options window is displayed when the HOST option is selected when in 
IMS Setup. 

 Image Size Mode 

Determines the IMS response to an image size request from a host using the 831/952 command 
set. 

 Alarm Mode 

Specifies how the IMS reports alarms to a host using the 959 command set. When set to Old, all 
alarms are reported to the host. When set to New, operator-recoverable alarms (supply cartridge 
empty) are not reported to the host. 
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 P1: PRI to DCR/PAS 

Print timing delay for a host using the 831 command set. Specifies the delay between a print 
command and a decrement copy register response (if copies remain to be printed) or a pass 
response (for print complete). 

Range: 0 to 255 

 P2: DCR to DCR/PAS 

Print timing delay for a host using the 831 command set. Specifies the delay between the first 
decrement copy register response and the second decrement copy register response (if copies 
remain to be printed) or a pass response (for print complete). 

Range: 0 to 255 

 P3: STP to STC 

Print timing delay for a host using the 952 command set. Specifies the delay between the setup to 
print command and the stage complete response. 

Range: 0 to 255 

 P4: EXP to DCR/EOE 

Print timing delay for a host using the 952 command set. Specifies the delay between an expose 
command and a decrement copy register response (if copies remain to be printed) or an end of 
exposure response (for print complete). 

Range: 0 to 255 
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 P5: EOE to PTC 

Print timing delay for a host using the 952 command set. Specifies the delay between an end of 
expose command and a print complete response. 

Range: 0 to 255 

 P6: DCR to STC 

Print timing delay for a host using the 952 command set. Specifies the delay between the 
decrement copy register command and the stage complete response for printing multiple films. 

Range: 0 to 255 

 Rotate All Images 

Specifies the orientation of printed images. When set to Yes, all images are rotated 90 degrees. 
When set to No, images are printed in the standard format. Applies only to host control using the 
959 command set. 

 Memory Full Response 

Specifies the response sent by the IMS to notify the host of a memory full condition. Applies only to 
host control using the 831/952 command set. 

 952 Beta Override 

Specifies whether or not to override the beta table setting specified by a 959 command set host. 
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 Aspect Ratio 

Specifies the pixel aspect ratio of the source modality. Applies only to host control using the 959 
command set. For 969 keypad users, the aspect ratio is specified in the Keypad Configuration 
window. 

Range: 0.20 to 6.00 

 831 Cmd Set Beta Tables 

Specifies the interpolation tables to use when “sharp” or “smooth” prints are selected at the host 
console. Applies only to host control using the 831 command set (if the 952 Beta Override 
parameter is set to Yes, this also applies to 959 command set users). 

 Density Test Contrast 

Specifies the source of the contrast table to use for the density test. Applies only to host control 
using the 959 command set. The sources are: 

• NVRAM - uses the contrast table specified by the Contrast parameter on the Image Parameters 
window. 

• Linear - uses a linear contrast table. 

• Front Panel - uses the contrast table specified by the front panel setting on a 959. Applies only 
to the 959 Laser Imager. 

 Pixel Correction 

Specifies if formats are to be scaled to correct for differences in resolution between the 969 (311.5 
pixels per inch) and the 831/952/959 (300 pixels per inch). Applies only to host control using the 
959 command set. 
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 Slides 

Specifies whether 35mm or Super (magnification of 1) slides will be printed when a host using the 
959 command set requests slides. 

 Dual Switch 

Specifies if the system allows switching of the print destination to both Comm ports of the selected 
input module. If set to Yes, an SWI command received on either Comm port will switch the print 
destination for both users. If set to No, an SWI command will only affect the port it was received on. 
Applies only to host control using the 959 command set. 

 Framing 

Enables or disables image framing. When set to Yes, a 1-pixel frame is printed around each image. 
When set to No, frames are not printed. Applies only to host control using the 831/952 command 
set. 

 Scale Magnification 

Specifies whether or not to scale magnification values sent by the host. When set to Yes, 
magnification values are scaled by the same factor that formats are scaled. When set to No, 
magnification values are not scaled. Applies only to host control using the 959 command set. 

 Scale Format 

Specifies whether or not to scale formats to fit smaller film sizes. When set to Yes, formats sent by 
the host are scaled to fit on 11 x 14 inch or 8 x 10 inch film. When set to No, formats are not scaled. 
Applies only to host control using the 959 command set. 

 System Parameters Window 

The System Parameters window is displayed when user selects the SYSTEM option when in IMS 
Setup. 
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 Parameter Set 

Specifies which of two EIB parameter sets will be used for acquisitions controlled by the selected 
input module/comm port. Each EIB can be connected to two source modalities. Two parameter 
sets are provided to allow the EIB to be configured differently if the two image sources are not 
identical. Normally, parameter set 0 is matched to comm port 0 and parameter set 1 is matched to 
comm port 1. This parameter is not displayed when the MPC is connected to a 969 laser imager. 

 User Priority 

Specifies whether the user’s print requests will be placed in the High priority or Normal priority print 
queue. The High priority queue must be empty before the Normal priority queue is processed. The 
suggested use of High priority is for a keypad that is dedicated to emergency print requests, or for 
ultrasound or other users that do not have image memory and require the patient to remain on the 
table until films are available. 

 FIB Port 

Specifies the Fiber Interface Board (FIB) port (0 or 1) to which the DEIB, EVEIB, VEIB, or SEIB is 
connected. Not displayed when connected to a 969 laser imager or 959 laser imager. 

 Interface 

For the 959, 969, and 8800 Multi-Input Manager, specifies the type of External Interface Box (EIB) 
connected to the selected input module. For the 8700 Plus, specifies the type of EIB connected to 
the FIB in the 8700. For the 8700 Standard, specifies the type of Interface Board (IB) installed in 
the 8700. 
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 Media Size 

Specifies the size of film loaded in the imager. 

Range (969/959): 8 x 10, 11 x 14, 14 x 17 

Range (8500/8700): 11 x 14, 14 x 17 
The Media Size setting on 969/959 keypads (local and remote) will override this setting. 

This parameter is not displayed when the MPC is connected to a 959. 

 Media Type 

Specifies the type of film loaded in the imager. 

Range (969/959): BWGen, HQB, HQC 

Range (8500/8700): BWGen, DryB, DryC 
This parameter is not displayed when the MPC is connected to a 959. 

 ID Foreground Intensity 

Specifies the density of characters printed in the User ID. 

Range: 0 (Black) to 4095 (Clear) 
This parameter is not displayed when the MPC is connected to a 959. 

 ID Background Intensity 

Specifies the density of the background for the User ID. 

Range: 0 (Black) to 4095 (Clear) 
These parameters are not displayed when the MPC is connected to a 959. 
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 Requeue 

Specifies the number of print copies to be printed without being interleaved with prints from other 
jobs. After this number of copies has been printed, any remaining copies are requeued. 

This parameter is not displayed when the MPC is connected to a 959. 

 Destination 

Specifies the default output destination. 

This parameter is not displayed when the MPC is connected to an 8700. 

 Modality 

Specifies an ASCII string used to identify the image source connected to the selected input 
module/comm port. The string has a maximum length of 20 characters and is displayed in the 
Configuration and Versions window, the Print Count window, and the component select drop-down 
list. 

 User ID 

Specifies an ASCII string used to identify the image source and user connected to the selected 
input module/comm port. This string is printed at the top of each film and the user information area 
on HQ local keypad. The maximum length of the string is 35 characters for the 969 HQ and 64 
characters for the 959 XL and 8700. 

 SCB/MCS Setup Windows 

The SCB/MCS Setup windows are displayed when the user selects the SCB or the MCS 
subsystem button and Setup under the Operations menu. 
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 Select Script File Window 

The Select Script File window defines the filename of the OEM script file to be loaded, as well as 
the drive and directory in which the file is located. OEM script files are used to set up the input IMS 
parameters directly from a file. 

The default drive and directory is the drive and directory of the MPC for Windows software. By 
default, only script files with a .SC extension are displayed in the File Name list box. Wildcard 
characters can be used to display other files. 

 969 Imager Setup Window 

The 969 Imager Setup window is displayed when the Config window display button is selected. 

 Left Edge Of Image 

Specifies a horizontal offset (in pixels) between the start of scan location and the left edge of the 
image area on the film. Decreasing the value moves the image area toward the left edge of the film; 
increasing the value moves the image area toward the right edge of the film. 

Range: 148 to 510 (Even numbers only; odd numbers will be rounded down.) 

Default Setting: 256 
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 Top Of Image 

Specifies a vertical offset (in pixels) between the top of the film and the top of the image area on 
the film. Decreasing the value moves the image area toward the top of the film; increasing the 
value moves the image area toward the bottom of the film. 

Range: 0 to 255 

Default Setting: 180 

 Language 

Specifies the language used for messages displayed on the local panel of the 969 imager. 

 8700 Imager Setup Window 

The 8700 Imager Setup window is displayed when the Config window display button is selected. 

 Total Prints 

Specifies the total print count stored in NVRAM on the SCB. 

 Maximum Pickup Retries 

Specifies the maximum number of times that the 8700 will attempt to feed a sheet of film from the 
supply cartridge before generating an error message. 

Range: 1 to 99 

 Language 

Specifies the language used for messages displayed on the local panel of the 8700 imager. 

 Machine Serial Number 

Displays and edits the current machine serial number stored in NVRAM. 
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 Allowing Serial Numbers Between 8X00000 and 8X00500 

When a technician types a serial number in this range, an input box displays asking the FE to re-
type the number.  If the number is identical to the previously typed number, MPC allows the serial 
number to be set to the new number.  If the number differs from the previously typed number, the 
input box states, “You have typed in a questionable serial number.  Please re-enter the serial 
number.” 

 Film Type Window 

Clicking the CE Mark / Film Types button on the 8700 Imager Setup window displays the Film 
Type window.  The CE Mark / Film Types button only displays if MPC was accessed with a 
softkey and the SCB version is greater than 1.29. 

The SHOW command is used to determine what appears in the drop-down lists. 

The Film Type window contains two drop-down list boxes and two buttons. 

 Film Cartridges Accepted Drop-down List 

The Film Cartridges Accepted drop-down list has two choices: 

• CE Mark (Conformité Européene) 

When the CE Mark is selected, the Film Types Accepted drop-down list is enabled. 

• All 

When the All is selected, the Film Types Accepted drop-down list is disabled. 

 Film Types Accepted Drop-down List 

A choice of what film types the printer accepts can be chosen from the Film Types Accepted drop-
down list. The film types choices are: 

• Clear and Blue 

• Clear and Blue+ 
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The default value is Clear and Blue. 

 Cancel Button 

Clicking the Cancel button causes the window to close and no choices are sent to the SCB. 

 Save Changes Button 

Click the Save button sends the following commands to the SCB. 

Film Cartridges Accepted Drop-
down List Box 

Film Types Accepted Drop-down 
List Box 

 
Commands 

All N/A Set CEMarkReqU “NO” 

Set filmtypesupported=1792 

CE Mark Clear and Blue Set CEMarkReqU “YES” 

Set filmtypesupported=768 

 Clear and Blue+ Set CEMarkReqU “YES” 

Set filmtypesupported=1280 

 

 Processor Setup Windows 

The Processor Setup windows are displayed when the PROC subsystem option is selected and 
the Setup Menu option in the Operations menu is selected. 

 Processor Configuration Window 

The Processor Configuration window is used to calibrate the 8700 temperature sensors and to 
specify a relative dryness level. 
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 Processor Parameters Window 

The Processor Parameters window is displayed when the MEDIA option is selected from the 
Processor Setup window. 

 Media Specific Parameters: Transport Motor Speed 

Specifies the transport motor speed to use for each type of film. 

Range: 15 to 38 millimeters per second 

 Processor Calibration Window 

The Processor Calibration window is displayed when the CALIB option is selected from 
subsystem PROC in setup mode. 

The heaters in the 8700 processor are adjusted by the use of arrow buttons. Adjustment of the 
temperature of each zone is performed by clicking on the appropriate arrows or by entering positive 
or negative values (representing click counts) in the numeric fields below the arrows. 

 EIB Setup Windows 

The EIB Setup windows are displayed when the EIB subsystem option is selected and Setup from 
the Operations menu. 

 Digital Parameters Window 

The Digital Parameters window is displayed when the CONFIG option is selected in EIB Setup for 
EIB Types of DEIB and DIB. 
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 Test Pattern 

Enables or disables use of the test pattern PROMs in the DEIB. When set to Enable, the test 
pattern PROMs are used as the image source instead of the source modality. The test pattern 
PROMs should only be enabled for diagnostic purposes for normal operation; this parameter must 
be set to disable. 

 Header Mode 

Specifies whether a header precedes image data, and if the image data is sent line-by-line or as an 
entire frame. The settings are: 
• Header/Frame - the image is preceded by a header and is sent as an entire frame. 

• Header/Line - the image is preceded by a header and is sent line-by-line. 

• Non-Header/Frame - the image is not preceded by a header and is sent as an entire frame. 

• Non-Header/Line - the image is not preceded by a header and is sent line-by-line. 

• Ignore Header/Frame - the image is preceded by a header that must be ignored (due to timing 
problems), and the image is sent as an entire frame. 

• Ignore Header/Line - the image is preceded by a header that must be ignored (due to timing 
problems), and the image is sent line-by-line. 

 Prescale 

Specifies whether or not to scale the digital timing scheme expected by the imager. 

 Parity 

Specifies the type of parity used by the image source digital interface. This parameter is ignored if 
the Parity Enable parameter is set to disable. 
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 Parity Enable 

Enables or disables parity checking of image data. 

 Port 

Specifies the DEIB/DIB input port (0 or 1) to which the image source device is connected. 

 Timeout 

Specifies the time (in seconds) allowed for a successful acquisition. 

Range: 0 to 4095 

 Pixels Per Line 

Specifies the number of pixels in a line of image data. When operating in Non-Header or Ignore 
Header mode, set this to match the image source pixels per line. When operating in Header mode, 
this parameter is ignored. 

 Image Lines 

Specifies the number of lines in each image. When operating in Non-Header or Ignore Header 
mode, set this to match the image source lines per image. When operating in Header mode, ignore 
this parameter. 

 Pixel Width 

Specifies the number of bits per pixel of image data. Set this to match the image source bits per 
pixel. 

 Digital Timing 

The default settings for T6, T7, and T10 make the imager timing compatible with a standard digital 
interface. 
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 Video Parameters Window 

The Video Parameters window is displayed when the CONFIG option is selected when in EIB 
Setup for EIB Type of VEIB, Enhanced VEIB, or VIB. 

 Vertical Delay 

Specifies the number of lines in the vertical sync back porch. Vertical delay is the number of lines 
from the first image line back to the trailing edge of the vertical sync pulse. For interlaced video, 
vertical delay is the number of alternate equalizing pulses. 

 Image Lines 

Specifies the number of active image lines in a frame of video. For interlaced video, a frame is 
comprised of two fields. 

 Horizontal Delay 

Specifies the number of pixels between the leading edge of the horizontal sync pulse and the first 
pixel of image data. 

Horizontal Delay (Pixels) = Horizontal Delay Time x Pixel Clock Frequency 

 Horizontal Active Pixels 

Specifies the number of pixels of active image data in a line of horizontal video. 

Horizontal Active Pixels = Horizontal Active Time x Pixel Clock Frequency 

 Clock Delay 

Specifies the delay that shifts the sampling of the video to the portion of the pixel that is the most 
stable. 
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 Fine Pixel Delay 

Specifies a delay that, in conjunction with the Clock Delay, centers the video sampling window in 
the middle of the pixel. 

 Black Level 

Specifies an adjustment that moves the black level voltage as close as possible to 0 volts. 

 Digital Gain 

Specifies the digital gain applied to the incoming video signal by the EVEIB or VIB. 

Range: 0 to 255 

 Pixel Clock Frequency 

Specifies the pixel clock frequency used by the video source. This value is used to determine the 
delay selections for Fine Tuning. 

Range: 4 to 125 MHz 

 Horizontal Frequency 

Specifies a frequency range that encompasses the calculated horizontal frequency value. 

Horizontal Frequency = 1 / Horizontal Line Time 

 Double Gain 

Specifies a voltage range that encompasses the amplitude of the incoming video signal.  

 Port 

Specifies the VEIB/EVEIB/VIB input port (0 or 1) to which the image source device is connected. 
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 Passes 

Specifies the number of video passes required to acquire each horizontal line of image data. This 
number is a function of pixel clock rate and the sample rate of the A/D converter in the VEIB, 
EVEIB, or VIB. The higher the clock rate, the more passes required. 

Range (969/959): 3 to 15 (odd numbers only)  

Range (8500/8700): 3 to 32 (odd and even numbers)  

 Window Width 

Specifies the width of the sampling window used for analog to digital conversion. 

 Retries 

Specifies the number of times the VEIB will attempt to acquire if the first attempt fails. 

 Video Input 

Specifies the type of video input to the EVEIB Types of video input: 

Standard - Standard composite video, with the video, horizontal sync, and vertical sync all on the 
same channel. 
• Video, H/V Sync - Two channels, with one for the video and one for the horizontal and vertical 

syncs. 

• Video, H Sync, V Sync - Three channels, with one for the video, one for the horizontal sync, 
and one for the vertical sync. 

 Clock Range 

This parameter is for video sources that do not have an external clock. This value will call the PLL 
module when no sync pulses are present (no video). 
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 Clocks Per Line 

This parameter is defined when a PLL module is executed. It specifies the number of clock pulses 
generated by the PLL between each horizontal sync pulse. The frequency of the PLL is adjusted 
when this parameter is changed. 

Clocks per line is calculated as: 

Sync to Sync Time = 1 / Horizontal Frequency 

Clocks (Pixels) Per Line = Pixel Clock Frequency x Sync to Sync Time 

 Source 

Specifies if the source video is interlaced or non-interlaced. 

 Start Frame 

This parameter specifies if a frame of interlaced video starts with even or odd numbered lines.  

 Advanced Video Parameters Window 

Advanced video parameters are used with modalities that provide a non-standard video signal that 
does not conform to the EIA RS-170 specification, e.g., Toshiba X-Vision, Toshiba X-Press/SX, 
Siemens Icon Power PC/Apple monitor modalities, and ADAC DPS 4000 and 4100 series (Version 
II or less). 

 Vertical Sync Detect 

Delays the detection of the vertical sync from the composite sync imbedded in the video signal. The 
vertical sync detect function must provide a single pulse per video field and must occur within ¼ 
line time from the leading edge of the actual vertical sync. 
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 Black Level Window 

Specifies the width of the Black Level window. The Black Level window sampling pulse must fall 
entirely within the horizontal sync time. 

 Video Fine Tuning Window 

The Video Fine Tuning window provides for fine tuning the video parameters. 

 Gain/Black Level Button 

After the Gain/Black Level option is selected, MPC requests the imager acquire an image. For 
959/969/8800 systems, the image is printed with grid marks every ½ inch along the left and bottom 
edges of the film. After the film has been printed, the Video Gain & Black Level Adjust window is 
displayed. 

For 8700 systems, the Gain and Black Level Rectangle Selection window is displayed. 

 Bad Clock Delay Button 

After the Bad Clock Delay option is selected, MPC requests the imager acquire an image and print 
the image using 16 different coarse clock delay settings in a 16:1 format. After the images have 
been printed, the Bad Clock Delays window is displayed. 

 Fine Pixel/Clock Delay Button 

After the Fine Pixel/Clock Delay option is selected, MPC requests the imager acquire an image, 
and prints it using 16 different combinations of Fine Pixel and Clock Delays. The 16 images are 
printed in a 4:1 format on four sheets of film. The Fine Pixel and Clock Delays are printed above 
each image.  

 Print 1-Up Button 

When this option is selected, the Video Fine Tuning - Print Full Size window is displayed. 
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 Gain & Black Level Fine Tune Window 

The Video Gain & Black Level Adjust window is displayed for the 959, 969, and 8800 systems. 
The Gain and Black Level Rectangle Selection window is displayed for the 8500 and 8700 
systems. These windows are used to define a rectangular image area containing true black and 
true white. The VEIB/EVEIB/VIB samples the data in this area, converts the analog data to digital 
values, and passes the minimum and maximum digital values to MPC. These values are displayed 
in the Gain & Black Level Fine Tune window, along with the current Black Level setting. For the 
EVEIB and VIB, the current Digital Gain setting is also displayed. 

The minimum digital value corresponds to true black. The maximum digital value corresponds to 
true white. 

If the video signal is via EVEIB or VIB, MPC interacts with the video generator to adjust the gain 
automatically. 

If the video signal is via VEIB, the gain is adjusted manually via the gain pot in the VEIB. MPC 
waits for the OK option to be selected. 

 Video Gain & Black Level Adjust Window 

The Video Gain and Black Level Adjust window is used to specify the coordinates of a 
rectangular area on the image that includes true black and true white. The coordinates are based 
on the grid marks and define the upper-left and lower-right corners of the rectangle. 

 Gain and Black Level Rectangle Selection Window 

The Gain and Black Level Rectangle Selection window displays an image downloaded from 
image memory. 

 Bad Clock Delays Window 

After the Bad Clock Delay option is selected, MPC requests the imager acquires and prints in a 
16:1 format. Each of the 16 images is printed using a different coarse clock delay setting (the 
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setting used is printed above each image). The Bad Clock Delays window is used to specify which 
clock delay settings (if any) produce images that exhibit vertical-line pixel shifting or pixel dropout. 

 Video Fine Tuning - Print Full Size Window 

The Print Full Size option requests the imager to print 16 images in a 1:1 format. 

 SCSI Parameters Window 

The SCSI Parameters window is displayed when the CONFIG option is selected in EIB Setup. 

 Test Pattern 

Specifies if one of the SEIB’s internal test patterns is to be used as the image source instead of the 
source modality. 

 Header 

Specifies whether a header precedes the image data. 

 Parity 

Specifies the type of TAXI parity used. It doesn’t matter which setting is selected; either will work. 

 Parity Enable 

Enables or disables TAXI parity checking. 

 Pixels Per Line 

Specifies the number of pixels in a line of image data. When operating in Header mode, this 
parameter is ignored. 
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 Image Lines 

Specifies the number of lines in each image. When operating in Header mode, this parameter is 
ignored. 

 Print Reconnect 

Specifies the minimum time (in microseconds) that the SEIB must wait before attempting to 
reconnect to a host that was previously disconnected. A value of 0 specifies no immediate 
reconnect. 

Range: 0 to 999 

 Print Disconnect 

Specifies the maximum time (in milliseconds) that a single SCSI PRINT command must be active 
before the SEIB disconnects from the SCSI bus. A value of 0 specifies no timeout. 

Range: 0 to 999 

 Acquire Timeout 

Specifies the maximum time (in seconds) allowed for a successful acquisition. 

Range: 0 to 999 
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 Reserve Timeout 

Specifies the maximum time (in minutes) that a host can hold the SEIB in the reserved state 
without performing any commands over the SCSI bus. A value of 0 specifies no timeout. 

Range: 0 to 999 

 Disconnect Timeout 

Range: 0 to 999 

 AIQC Setup Windows 

The AIQC Setup windows are displayed when the AIQC subsystem option is selected and Setup 
under the Operations menu. 

 AIQC Window 

The AIQC window is displayed when the CONFIG option is selected when in AIQC Setup. 

 Default Film Model 

Specifies the default film model to use when either the darkroom load supply magazine is being 
used or the transfer function EPROMs do not contain a film model that matches the film type 
specified by the bar code label on a daylight load supply cartridge. Not displayed for a DryView 
8500 or DryView 8700 imager. 

Range: 0 to 16 (3 = IRB+, 4 = IRC+, 5 = HQB, 6 = HQC) 
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 Idle Minutes Between Calibration 

Specifies the number of minutes of idle time that will trigger an automatic calibration sheet. Idle 
time is the time that has elapsed since the last film exited the system. 

Range: 0 to 8000 

 Minimum Laser Dynamic Range 

Specifies the minimum allowable laser dynamic range for the optics module. Not displayed for a 
DryView 8500 or DryView 8700 imager. 

Range: 30 to 120 

 Maximum Laser Dynamic Range 

Specifies the maximum allowable laser dynamic range for the optics module. Not displayed for a 
DryView 8500 or DryView 8700 imager. 

Range: 70 to 255 

 Density Step With AIQC Off 

Increment setting that sets density setting of film from the rated Dmax of the film. 

Range: 0.05 to 0.50 
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 Speed Variance 

Specifies the maximum variance from the target speed point that the system will allow before 
generating a warning that the system is operating near calibration limits. 

Range: 0.1 to 0.5 

 Chemistry 

Specifies the type of chemistry used in the processor. This parameter is only applicable to M969. 

Range: 1 to 5 

 Display Defaults Button 

Displays the default values for all the AIQC parameters. 

 DLogE Curves Window 

The DLogE Curves window displays a graph showing the measured and nominal DLogE curves. 

The drop-down list box above the graph displays the actual measured DLogE data. The data is 
presented as pairs of numbers. The first number in each pair is the measured density, and the 
second number is the exposure (expressed as LogE) required to produce that density. (The same 
number pairs are used to plot the measured DLogE curve on the graph.) 

The measured film speed (i.e., LogE at Dmax) is displayed in the upper-left corner of the window. 

The Print Option prints the graph and the data. 

The Save option will save the window and the data in a specified data file. 

 Load TFT Window 

The Load TFT window is used to specify the name of the Transfer Function Table file to be loaded, 
as well as the drive and directory in which the file is located. 
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 KPD Setup Windows 

The KPD Setup windows are displayed when the KPD subsystem option is selected and Setup 
option under the Operations menu. 

 Keypad Configuration Window 

The Keypad Configuration window is displayed when the CONFIG option is selected from the 
Keypad Setup. 

 Language 

Specifies the language to use on the keypad display. 

 Pixel Aspect Ratio 

Specifies the pixel aspect ratio of the source modality. This parameter applies only to 969 keypad 
users. 

Range: 0.20 to 6.00 

 Smooth Beta 

Specifies the interpolation table to use when smooth image processing is selected at the keypad. 

Range: 0 to 15 
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 Sharp Beta 

Specifies the interpolation table to use when sharp image processing is selected at the keypad. 

Range: 0 to 15 

 Debug 

Specifies whether or not the keypad should operate in debug mode. When in debug mode, the 
keypad sends out debug messages, which allow communications between the keypad and the IMS 
to be monitored. 

 8700 Keypad Configuration Window 

The 8700 Keypad Configuration window is displayed when the CONFIG option is selected in 
Keypad Setup. 

 Language 

Specifies the language to use on the keypad display. 

 Default Format 

Specifies the default format selected on the 8700 keypad when the system is powered up. 

Range: 1:1, 2:1, 4:1, 6:1, 9:1, 12:1, 15:1, 16:1, 20:1 

 Pixel Aspect Ratio 

Specifies the pixel aspect ratio of the source modality. 

Range: 0.20 to 6.00 

 Auto Print 

Specifies if the auto print function is enabled. 
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 Select Format Window 

The Select Format window is displayed when the SAVE or LOAD option is selected in Keypad 
Setup. The Select Format window is used to select which keypad custom format (A, B, C, or D) is 
to be loaded from disk or saved to disk. 

 Load Keypad Custom Format Window 

The Load Keypad Custom Format window is used to specify the name of the keypad custom 
format file to be loaded, including the drive and directory. 

 Save Keypad Custom Format Window 

The Save Keypad Custom Format window is used to specify the name of the keypad custom 
format file to be saved, including drive and directory. 

 IMS Diagnostics Windows 

The following diagnostic windows are available when: 

• Diagnostic mode is selected via the Operations menu 

• The IMS subsystem option and Diagnostics are selected under the Operations menu 

 Output Module Diagnostics Window 

When selected by selecting the TEST option. The options in the Output Module Diagnostics 
window initiate various tests of the output module. 

 Output Module Memory Test 

Performs a standard memory test on all dual port RAMs that contain output module parameter 
blocks, and reads and writes to all hardware registers. Also verifies the checksum of NVRAM to 
ensure that the contents have not been corrupted. Does not test communication microprocessor 
memory or NVRAM (except for checksum). 
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 Output Module Image Processing Test 

Uses the onboard pattern generator in the output module to test filtering, interpolation, and output 
formatting functions in the output module. 

 Output Module NVRAM Test 

Tests the function of NVRAM. The contents of NVRAM are temporarily saved in RAM at the start of 
the test and then restored when the test is complete. 

 Output Module Comm. RAM Test 

Tests the 4-Kbyte dual port RAM associated with the communication microprocessor. 

 Output Module Comm. Functionality Test 

Tests the function of the communication microprocessor and two associated comm ports. The 
microprocessor transmits a stream of characters on the transmit line and reads back this data on 
the receive line of each port. The characters read in are checked against the source to ensure that 
data is not being lost or altered. 

 Input Module Diagnostics Window 

The options in the Input Module Diagnostics window initiate various tests of the input module. 

 Image Memory Test 

Performs a standard memory test on the image memory in the selected module. The test writes a 
pattern, reads and verifies the pattern, flips the bits, and then performs another write/read/verify 
cycle. 
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 Non-Image Memory Test 

Tests the function of all non-image memory and hardware registers in the selected module. Also 
verifies the checksum of NVRAM to ensure that the contents have not been corrupted. Does not 
test image memory, communication microprocessor memory, or NVRAM (except for checksum). 

 NVRAM Test 

Tests the function of NVRAM. The contents of NVRAM are temporarily saved in RAM at the start of 
the test and then restored when the test is complete. 

 Comm. RAM Test 

Tests the 4-Kbyte dual port RAM associated with the communication microprocessor. 

 Comm. Functionality Test 

Tests the function of the communication microprocessor and two associated comm ports. The 
microprocessor transmits a stream of characters on the transmit line and reads back this data on 
the receive line of each port. The characters read in are checked against the source to ensure that 
data is not being lost or altered. 

 SCB/MCS Diagnostics Windows 

The following diagnostic windows are available when: 

• Diagnostic mode is selected via the Operations menu. 

• The SCB or the MCS subsystem option and Diagnostics is selected from the Operations 
menu. 
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 Imager Status Window 

The Imager Status window displays the current status and error conditions for the imager. This 
window is displayed when the Status window display button is selected from the subsystem MCS 
(M969) or SCB (M8700) in Diagnostics mode. 

 Imager Diagnostics Window 

When selected, the options in the Imager Diagnostics window initiate tests of various components 
within the 969. 

 Serial Line Test 

Issues a Test Echo command that transmits a string of characters over the serial communications 
line between the MCS CPU Board (PWA-A) and the output module for the selected printer. 

 Transport Processor 

Initiates a transport print through the printer and the processor. The film is not exposed. 

 Transport Magazine 

Initiates a transport print through the printer and into the receive magazine. The film is not exposed. 

 Reset 

Sends a reset command to the selected printer, initiating the power up self-diagnostics. 

 Motor On Buttons 

Sends a command to the imager to turn on the selected motor. 

 Motor Off Buttons 

Sends a command to the imager to turn off the selected motor. 
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 Solenoid Buttons 

Sends a command to the imager to momentarily energize the selected solenoid. 

 Imager Switches Window 

The Imager Switches window displays a list of the switches within the 969 with a checkbox 
preceding each switch. An X in the checkbox indicates that the switch is actuated. The switch is not 
actuated when the checkbox is blank. This window is displayed when the SWITCH option is 
selected from subsystem MCS in diagnostics mode. 

 Imager Sensors Window 

The Imager Sensors window displays a list of the sensors within the 969 with a checkbox 
preceding the sensor. An X in the checkbox indicates that the sensor is actuated. The sensor is not 
actuated if the checkbox is blank. This window is displayed when the SENSOR option is selected 
from subsystem MCS in diagnostics mode. 

 Command Entry Window 

The Command Entry window sends commands to the connected device. This window is provided 
mainly for use by lab personnel. This window is displayed when the CMD button is selected from 
subsystem MCS (M969) or SCB (M8700) in diagnostics mode. 
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 Test Motors Window 

The Test Motors window provides options to energize the motors within the 8500/8700. The 
selected motor remains energized for ten seconds. The locations of the motors are: 

• Pickup: Right side of pickup module 

• Multifeed: Right side of transport module, just above platen motor 

• Platen: Right side of transport module, just below multifeed motor 

• Transport: Left side of transport module 

• Exit: Right side of exit assembly 

• Rollback: Right side of rollback module 

 Sensor Window 

The Sensor window displays a list of the sensors within the 8500 and 8700 with a checkbox 
preceding each sensor. An X in the checkbox indicates that the sensor is actuated. The sensor is 
not actuated if the checkbox is blank. The locations of the sensors are: 

• Pickup Bottom: Underside of pickup arm assembly, closer to left side 

• Pickup Middle: Left side of pickup module, closer to back 

• Pickup Top: Left side of pickup module, closer to front 

• Cartridge Open: On moving portion of rollback tray 

• Rollback Home: Rear of rollback module, near right side 

• Cartridge Present: Rear of rollback module, near center 

• Tongue Depressor: Front of transport module, near top 

• Film Out: Underside of pickup arm assembly, closer to right side 
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• Multifeed: Top of transport module, near right side. (Multifeed 1 indicates one sheet detected; 
Multifeed 2 indicates more than one sheet detected.) 

• Double Feed: Middle of transport module, near top 

• Exposure Entrance: Front of transport module, near bottom 

• Exposure Bottom: Underside of platen 

• Exposure Exit: Back of transport module, near bottom 

• Transport Midpoint: Back of transport module, near top 

• Processor Entrance: On film guide underneath processor. 

• Densitometer: Inside densitometer 

• Transport Exit: On left end of exit assembly 

• Filter Present: Inside filter housing 

• Attenuator Home: In optics module 

• Laser Interlock: One inside platen, and one on left front corner of frame 

• Top Interlock: Inside right rear corner of frame, behind processor 

• Front Interlock: On frame behind supply door 

• Side Interlock: On left front corner of frame 

• Interlock Override: On frame behind right side panel 
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 Test Solenoids Window 

The Test Solenoids window provides options to energize the various solenoids within the 8500 and 
8700. The selected solenoid remains energized for five seconds. 

The locations of the solenoids are: 

• Doublefeed: Upper left side of transport module 

• Gate: Lower left side of transport module 

• Align: Underside of platen, two on left side and two on right side. 

• Hold: Underside of platen, near platen entrance 

• Kick: Inside platen, at bottom 

• Tongue: Upper right side of transport module 

• Valve: On pickup module, next to vacuum pump 

• Supply Door: On frame behind supply door 

• Left Door: Front left corner of frame 

 Print Test Images Window 

The Show Image Test option occurs only when MPC has been logged onto with the softkey 
method. 

• Print Test Images: Calibration - Prints a calibration sheet 

• Print Test Images: Grey Out - Prints a grey out with the specified attenuator setting 

• Print Test Images: HIB Internal - Prints the internal HIB image for an 8500 or 8700 based on the 
defined density setting 

• Print Test Images: Transport Only - Prints a defined number of transport print films 
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• Print Test Images: ByPass Warm Up - Bypasses the initial warm-up as the imager is initializing 

• The Sensor screen allows monitoring the sensors as film goes through the imager 

• Optics Test: Documents the SCB startup procedure 

 Optics Test Window 

The optics tests are in the SCB and are done on bootup of the SCB.  There is a SCB reset button 
on the SCB board (10F1). The reset button is depressed and then the Start button is clicked in the 
Optics Test window.  The software sets up a file in the Application directory that records the test 
as it comes over the monitor.  This software has a 10-second delay to allow the SCB to bootup.  
After the delay, MPC sends the command "set lpprintf=84." This command enables the front panel 
to receive the text from the optics test. Then MPC continually sends the "show lpprintf" command to 
receive the text. The software continues to send the command until the received text differs from 
the previous text.  When it does, the new line is parsed and calculations are done to see if there is 
an error occurring.  If there is an error the error text box is updated with the appropriate message 
and the routine is terminated.  If there are no errors then the software returns to sending the 
command and receiving text. 

 Text Window 

The Text window displays the raw text. The following paragraphs list the raw text along with a short 
explanation of the text and the number of the error that occurs if the parameters are out of range.  
The example shows the text as it would appear on the text window. 

1. EMax Max,  EMax Min: Maximum and Minimum Laser power that does not saturate the Beam 
Power Monitor 

Example: [emaxMax, emaxMin =  3150, 2250] 
2. PM Offset : Beam Power Monitor Offset a number between 1 and  25 usually  3 +/- 3.  If not 

Error 601 occurs 

Example: [pmOffs et = 10] 
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3. Ltest: A digital value assigned to the Laser Power and used to perform the following tests 

Example: [Ltest = 30 60] 
4. PM Atten open: Power Monitor reading with Attenuator wide open should be 2250 to 3882. If 

not a 602 occurs 

Example: [pmAttenOpen = 3 198 {2276..3882}] 
5. AOD Range: Attenuator Optical Density Range a number between 0.8 thru 1.2.  If not a 603 

error occurs 

Example: [A ODrange = 0.954243  {0.800000..1.200000}] 
6. Laser Dynamic Range: Laser dynamic range  -  a ratio of Max and Min power - a number 

between 200 thru 4000.  If not a 604 error occurs 

Example: [laserDynamicRang e = 3238] 
7. PML Test: The Attenuator position used to accomplish the following tests 

Example: [pmLtest =  820] 
8. PM Laser Min,  PM Laser Max: Minimum and Maximum Laser power at above Attenuator 

setting – a number between 1 to 2995 

Example: [pmLaserMin, p mLaserMax = 1, 3238 ] 
9. PABS Max: Power absolute Max in milliwatts  -  should be between  50 - 70 milliwatts  if not a 

605 error occurs 

Example: [Pabsmax = 63.1410 03] 
The data in the text window appears similar the following example. 

Send Yes ~SHOW Y LPPRINTF=[emaxMax, emaxMin =  3150, 2250][pmOffs et = 10][Ltest = 30 
60][pmAttenOpen = 3 198 {2276..3882}][A ODrange = 0.954243  {0.800000..1.200000 
}][laserDynamicRang e = 3238]Send Yes ~SHOW Y LPPRINTF=60][pmAttenOpen = 3 198 
{2276..3882}][A ODrange = 0.954243  {0.800000..1.200000 }][laserDynamicRang e = 
3238][pmLtest =  820][pmLaserMin, p mLaserMax = 1, 3238 ][Pabsmax = 63.1410 03] 
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 Error Field 

If an error occurs, the testing stops and the error code is displayed in the Error field.  The captured 
data is saved to a document whose location is listed in the File field. 

The error codes for the optics module are: 

• EC601. 

Invalid Power Monitor Offset - checks the Beam Power Monitor board with no laser beam hitting 
it. 

• EC602. 

Invalid Power Monitor Range - Optics Module Attenuator is wide open and a laser beam of 
specific intensity strikes the Beam Power Monitor.  The Beam Power Monitor then reports the 
Laser beam strength to the SCB board. 

• EC603 

Invalid Optical Density Range is a check of the Attenuator Optical Density range. 

• EC604. 

Invalid Laser Dynamic Range. 

• EC605. 

Attenuator Test Failed.  Attenuator could not be rotated to a position for proper output power 
The above self-test uses the Beam Power Monitor.  If the Beam Power Monitor fails the self-test 
will also fail. 

The self test will also send out line numbers of the code if a more serious error has occurred. 
These numbers can appear at any time during the self test and need to be looked at in every line 
that comes across the monitor.  If a line number comes across, the test is stopped and the line 
number is recorded in the file. 

Line number errors are: 
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• Attenuator cannot be set correctly:   V1.30 line 422;     Earlier releases line 412 

• Cannot find max position of attenuator:  V1.30 line 536;  Earlier releases line 526 

• Timed out waiting for X galvo to phase lock:  V1.30  line 852;  Earlier releases line 842 

Information about these errors is available by pressing F1 from anywhere on the Optics Test 
window. 

 PROC Diagnostics Windows 

The following diagnostic windows are available when: 

• Diagnostic mode is selected via the Operations menu 

• The PROC subsystem option and Diagnostics is selected from the Operations menu 

 Processor Operational Tests Window 

The Processor Operational Tests window options initiate tests of various components within the 
XP535. This window is displayed when the TEST option is selected from subsystem PROC in 
diagnostics mode. 

 Developer Heater Button 

Sends a command to the imager to energize the Developer Heater for ten seconds. 

 Developer Replenishment Pump Button 

Sends a command to the imager to energize the Developer Replenishment Pump for ten seconds. 

 Dryer Heater Button 

Sends a command to the imager to energize the Dryer Lamps for ten seconds. 
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 Dryer Fan Button 

Sends a command to the imager to energize the Dryer Fans for ten seconds. 

 Fixer Heater Button 

Sends a command to the imager to energize the Fixer Heater for ten seconds. 

 Fixer Repl. Pump Button 

Sends a command to the imager to energize the Fixer Replenishment Pump for ten seconds. 

 Recirculation Pump Option 

Sends a command to the imager to energize all three Recirculation Pumps simultaneously for ten 
seconds. 

 Rinse Valve Button 

Sends a command to the imager to energize the Rinse Valve for ten seconds.  

 Transport Motor Button 

Sends a command to the imager to turn on the Transport Motor for ten seconds. 

 Dry Drive ON  

Sends a command to the imager to turn on Dryer Fans, Dryer Lamps, and Transport Motor. 

 Dry Drive OFF 

Sends a command to the imager to turn off the Dryer Fans, Dryer Lamps, and the Transport Motor. 
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 Processor Sensors Window 

The Processor Sensors window displays a list of all the sensors within the XP535 with a checkbox 
preceding each sensor. An X in the checkbox indicates that the sensor is actuated. The sensor is 
not actuated if the checkbox is blank. This window is displayed when the SENSOR option is 
selected from subsystem PROC in diagnostics mode. 

 Densitometer Test Window 

The Densitometer Test window displays the A/D output values read during the densitometer 
calibration procedure 
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